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Atmel Product Introduction 

 MCU  

      ARM Based : Cortex-M0,M3,M4,M7 

                            (ex.  SAMD2x,SAMLx,SAM4x) 

      AVR Based :  AVR 8/16/32 bit MCU Series 

                            (ex. AVR, Atmegar, TinyAVR) 

 MPU  

      ARM Based : Cortex-A5 Series (ex. SAMDA5Dx) 

 

 RF and Connectivity  

     Zigbee (ex. SAMR21/AT86RF233) 

     BLE     (ex. BTLC100/SAMB11) 

     Wifi    (ex. WINC1500/WILC1000/SAMW25) 

     Sigfox (ex. ATA8520D)  

 

 Touch Key (PTC)  

       QT6 

       Max Touch 

 

 ETC 

      EEPROM/CRYPTO (ex. AT24C16D /ECC508) 

      Arduino / Sensors 
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Atmel Hardware tools 
Low cost hardware platforms for evaluation and rapid prototyping 

 

Xplained eval board platform 

• Extendable using Atmel extension boards or Arduino shields 

• All boards supported in Atmel Studio with example projects 

• All design files available. Easy to reuse in customer projects 

• On-board debugger on all boards 

 

• Debuggers & Programmers 

• Atmel-ICE Stand-alone debugging & 

   programming tool for all ARM/AVR cores 

• Atmel EDBG on-board debug solution for integration 

•  power debugger for high accuracy power measurement support 
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Atmel SW Development tools 
Strongest MCU tools portfolio on the market 

• Atmel Studio 

• Based on Visual Studio frontend, supports 8/32-bit AVR 

  and ARM development    & advanced debugging 

 

• Studio 7 adds migration path for makers to production  

   ready tools  684,000+ downloads since 2012 

 

• Atmel Data Visualizer 

• Oscilloscope view allows you to Monitor  application  

    behavior,   display data & interact with running applications 

 

• Renders power data while debugging.  

   Real time  power graphs that visually illustrate power modes 

 

• Q-Touch Studio & Wireless composer 

• Studio plug-ins for step-by-step guidance for  setting up  

     and testing touch & RF systems. 

 

• Available for free at atmel.com 
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Development Cycle with Atmel Device 

Fastest  
Time to 

Prototype 
& Production 

Addressing the complete product development cycle 

Reference 
Solutions  
Gallery 

Embedded 
Software & Device 
Configuration 
Tools 

Industry 
Leading 
IDE Tools 
& Eval Kits 

Atmel 

Best in class  
Low Power MCU’s 
& Wireless Solutions  

All backed by Atmel’s leading Customer Support ! 
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Improvement on 
Atmel Studio7 
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Latest Visual Studio Isolated Shell 

• Improved IDE responsiveness and startup times 

• Modern user interface with improved editing and 

 

Source code control features 

• Windows 10 support 

• Modularized installer to reduce size 

• 2MB Web Installer, selected components downloaded 

on demand 

• Reduces average download requirement by 50% 

• All selections done at start of installation, enables unatended installs. 

  Ease of use Visualization Tools 

• Support for Power visualization and Data visualization  

• Real time graph power - visually illustrating MCU power modes 

• Power Debugging 

 

Arduino project import 

• Ability to import Arduino sketches as C++ projects, creating a migration path for users that wish 

to go pro. 

 

Coming in Q4 - MPU support in Studio (SAMA5) 

• Support for SAMA5 devices(non MMU mode) will be added to Studio, as well as to the Atmel-ICE 

probe. 

Improvement on Atmel Studio 7 

Focus is on Ease of Use & Performance 
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Improvement on Atmel Studio 7 

 

 

 

 

 

 

 

 

 

 

 

 

 

New tool - Atmel Start (1) – http://start.atmel.com  
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Improvement on Atmel Studio 7 

 

 

 

 

 

 

 

 

 

 

 

 

 

Web based SW, no installation required. 

• Connected with My Atmel, always up to date. 

Explore software components, examples and complete reference solutions 

• Explore Atmel kits and examples / solutions 

• Repository of software components  

• Atmel SW, 3rd party SW and Open Source  
community SW 

Visual software & device configuration 

• Configure middleware and software drivers 

• MCU Pin mux, Peripherals and System clock 

• Automatic generation of clean, readable code 

IDE agnostic - supports code/project generation for Studio, IAR and Keil 

 

New tool - Atmel Start (2) – http://start.atmel.com  
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Improvement on Atmel Studio 7 

 

 

 

 

 

 

 

 

 

 

 

 

 

Help System Improvement (1) 

• Manage help content to download 

• Have up-to-date help 

• Users are notified of available updates 

• Help can be updated independent of Atmel Studio releases 

• Reduces download size of installer 

• Data sheets will be made available for search 
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Improvement on Atmel Studio 7 

 

 

 

 

 

 

 

 

 

 

 

 

 

Help System Improvement (2) 

• In editor and IO view: lookup datasheet & other prog. references  
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Improvement on Atmel Studio 7 

In editor and IO view: lookup datasheet & other prog. references 

Help System Improvement (3) 
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Atmel Data Visualizer 

Available in Atmel gallery 

• Processes and renders data collected 

   while debugging 

• Uses EDBG Data Gateway Interface, or 

    serial port on custom boards 

• Renders GPIO, SPI, TWI, USART.. Today. 

• Roadmap covers touch, motor feedback, wireless... 

• Power data supported starting with SAML21-XPRO 

• Can run as stand alone application 

• Pluggable view in Studio 7, stand alone for other IDEs 

Visualize power consumption during debugging 
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• Import Arduino project into Studio 

 

• Opened as a C++ project with 
include paths to the Arduino library 
source code 

From Maker to Market 

Ease path for Arduino users to move to Atmel Studio 
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Demo 
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Atmel Start 

A hub for software examples and solutions 

Solution 

Third party 

Examples 
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Dashboard and software configuration 
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Configure the clocks 
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Configure the pinmux 
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Project preview and exporting 

Project preview and exporting 
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Project preview and exporting 

Project preview and exporting 

Implementation 

examples included, in 

ATMEL_START.c 

 

These examples & 

comments become your 

quickstart guide.  
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Project preview and exporting 

Project preview and exporting 
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Project preview and exporting 

Project preview and exporting 
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Re-configure project 

Update and export  

new configuration 
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Re-configure project 

Update and export  

new configuration 
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Re-configure project 

Update and export  

new configuration 



29 ©  2015 Atmel Corporation 

• C 

• Inline configuration anotation is used to render the configuration 
GUI. 

• Doubles as human readable documentation 

 

// <o> Frame parity 

 // <0x0=>No parity 

 // <0x1=>Even parity 

 // <0x2=>Odd parity 

#define CONF_SERCOM_1_USART_PARITY  0x0 

 

12/9/2015 Select  Insert > Header & Footer > Type Title in Footer field 

CMSIS Configuration Anotation Notation  

Config files: Can test new config (but will be overwritten) 
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Atmel Start and ASFv4 

Agenda 

• Introduction to Atmel Start 

• Atmel START & ASF4 vs. ASF Wizzard & ASF3 

• Positioning & Messaging 

• Roadmap 

• Introduction to ASFv4 

• Current work/Future plans 
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• The Atmel START Configuration tool replaces the ASF Wizard, the code 
generated is ASFv4. 

 

• ASFv4 is a major upgrade to the Atmel Software framework, re-architected for 
low code footprint and low run-time performance overhead 

 

• ASFv4 is not 100% compatible, though the code style will be familiar for users 
of ASFv3 API, supporting the Atmel SAMD/L/C MCU's.  

  

• ASFv4 will be the main SW platform for new NPI work going forward. 

• Major new device platforms will only be supported on ASFv4. 

• Derivatives of devices on existing platforms may also be supported on ASFv3. 

 

• Maintenance will continue on ASFv3, in line with longevity commitments for 
supported parts, but the platform will not be developed further. 

 

 

 

 

 
 

Why ASF4? 

 

Messaging to existing customers 
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ASF 3 vs. Atmel Start + ASF4 

            ASFv3                              Atmel Start + ASFv4 
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ASF 3 vs. Atmel Start + ASF4 

               ASFv3                                   ASFv4 

Runtime configuration: In the project 

• Configuration structs must be populated 

• Configuration dependencies resolved and 
calculation done run-time which add code 
to the project 

 
Generic drivers 

• Tries to support all features in a module 

• Feature list changes with target device 

• #ifdefs used to enable/disable code 
depending on features supported by the 
device 

• One TC driver 

 

Common peripheral APIs 

• Usually wrappers on top of other drivers 

• Different function signatures 

 

 

 

 

 

12/9/2015 Select  Insert > Header & Footer > Type Title in Footer field 

Pre-compile configuration: Atmel Start 

• Configuration structs populated compile 
time  

• Configuration dependencies resolved and 
calculations done compile time 

 

Use-case driven drivers 

• Supports a subset of features 

• Feature list is the same on any device 

• Driver code much more tailored to 
application target 

• Separate drivers for PWM, Timer, Input 
capture 

 

Common peripheral APIs 

• All HAL APIs designed to be device 
agnostic 

• HAL implementation not changed for any 
device 

• (What common APIs should have been) 
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• Ease of use Visualization Tools 

• Support for Power visualization  
and Data visualization 

• Real time graph power  - visually  
illustrating MCU power modes 

• Power Debugging 

• Smaller Download and Faster 

• Modular download reduces download,  
web based updates and features 

• Latest MS Shell 2015 improves  
performance and startup times 

• Full Arduino Support “Maker to Market” 

• Import Arduino sketches as C++ projects  

• Supports Arduino HW boards with EDBG 

• (Arduino IDE will also start supporting  
Atmel Explained Kits)  

 

Atmel Studio 7 

Focus is on Ease of Use & Performance 
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Platform update 
Chose theme: Dark, blue or light 

Get update notifications 
 - New part packs availble 

Quick launch 

Tools -> Options -> General 
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Platform update 

Asynchronous project load 
- When loading many projects 

part of a solution 

- Solution explorer  

Preview selected item  
- single click file item to 

preview in solution explorer 

Search in: 
- Tools->Options 

- More easily find 

advanced config options 
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• Pack Manager lists installed devices 

• Offline support 

• Local packs can be added using the 
Pack Manager UI or the CLI 

• Studio device selection dialogs lists 
only installed devices 

• Check for updates 

 

Pack Manager - New device support mechanism  

Get support for the latest devices in Atmel Studio 
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• Import Arduino project into Studio 

 

• Opened as a C++ project with 
include paths to the Arduino library 
source code 

From Maker to Market 

Ease path for Arduino users to move to Atmel Studio 
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